In these United States, when you’re in real trouble you have but one number to call: 911. Back in 2000, while we were racking our brains for a title for Macworld’s tips and troubleshooting column, we invoked this emergency calling code, preceding it with Mac so that its humble author (me) wouldn’t be additionally inundated with requests for help with small appliances and domestic disputes. Thus Mac 911 (macworld.com/mac911) became the primary place to go within Macworld’s pages for help with all things Apple.

Since the column’s birth, we’ve seen the death (OS 9) and rebirth (OS X) of the Mac OS, the coming and going of countless Mac models, the explosion of the Internet, and the metamorphosis of Apple the computer company into Apple the media and telecommunications giant, responsible for two of the most game-changing products of the young century—the iPod and iPhone. Yet through all these changes, one constant remains: the desktops and laptops that we increasingly rely on for our work and pleasure sometimes act up in frustrating ways.

Fortunately, as frustrating as these hiccups may be, they are often predictable. In this guide, we’ve distilled the Mac troubleshooting knowledge we’ve acquired over many years of putting together columns. Thanks to the first chapter—Installation—OS X sits comfortably on your computer. But maybe the next day you press your Mac’s power button, and nothing happens. Chances are that you’ll find a solution to your problem in the next chapter of this guide, Startup Issues, Crashes, & Freezes. If you then discover your printer is misbehaving, simply thumb to the next chapter, Hardware Help. And so on through the System Issues & Fixes, OS X’s Applications, The Internet & Networking, and Mac Maintenance chapters.

And if, despite all your diligent efforts, no solution is found? There are directions for what to do next in the Support Tricks chapter. But allow me to also extend a personal invitation to Macworld’s Mac 911 forum (macworld.com/5222), where I and other knowledgeable Mac users are eager to lend a helping hand.

—Christopher Breen, senior editor
April 2010
# Table of Contents

## Installation

8  **Upgrading Your OS**  
Make sure the leap from Leopard to Snow Leopard goes as smoothly as possible with these installation tips.

14  **Installing Programs**  
Install new software on your Mac and know what to do when things don’t go according to plan.

## Startup Issues, Crashes, & Freezes

18  **Startup Woes**  
Follow these steps if your Mac is taking too long to start up—or if it won’t start up at all.

26  **Address Kernel Panics**  
Just because a kernel panics doesn’t mean you need to. Here’s what to do in case of a kernel panic.

27  **Application Freezes**  
We give you multiple ways to unfreeze a pesky frozen application.

28  **Application Crashes**  
These step-by-step instructions will show you how to handle an application crash and get your system running again.

## Hardware Help

34  **Printer Problems**  
Follow these directions if your printer won’t print, has queue issues, or is giving you other headaches.

40  **Hard-Drive Issues**  
Prevent unnecessary data loss by looking out for failing-hard-drive symptoms and fixing internal and external drive issues.

44  **Bad Memory**  
Diagnose and repair bad memory, which can cause persistent crashes, system slowdowns, and corrupted files.
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>47</td>
<td>Other Glitches and Fixes</td>
<td>Some other common problems that afflict laptop owners, messy eaters, and optical drive users.</td>
</tr>
<tr>
<td>52</td>
<td>System Issues &amp; Fixes</td>
<td><strong>Navigation Mishaps</strong>&lt;br&gt;Solve problems with navigation mainstays including Spotlight, the Finder, and the Dock.</td>
</tr>
<tr>
<td>56</td>
<td>System Settings Fixes</td>
<td><strong>System Settings Fixes</strong>&lt;br&gt;Take control of your system settings and make sure they work for you, not against you.</td>
</tr>
<tr>
<td>60</td>
<td>Built-in Troubleshooting Tools</td>
<td><strong>Built-in Troubleshooting Tools</strong>&lt;br&gt;Your Mac is filled with utilities to help you troubleshoot, including the Activity Monitor, Disk Utility, and hidden menu bar information.</td>
</tr>
<tr>
<td>64</td>
<td>OS X’s Applications</td>
<td><strong>Safari</strong>&lt;br&gt;Snow Leopard’s portal into the Web can run into snags from time to time. Get surfing again in a snap with these tricks.</td>
</tr>
<tr>
<td>68</td>
<td></td>
<td><strong>Mail</strong>&lt;br&gt;Mail, your Mac’s communication hub, looks simple but can be complicated to set up properly. We show you how to do it.</td>
</tr>
<tr>
<td>75</td>
<td>iCal</td>
<td><strong>iCal</strong>&lt;br&gt;Stay on schedule and handle unforeseen calendar calamities.</td>
</tr>
<tr>
<td>78</td>
<td>Other OS X Programs</td>
<td><strong>Other OS X Programs</strong>&lt;br&gt;Tame OS X’s other apps, such as iChat, Preview, and Address Book, if they give you problems.</td>
</tr>
<tr>
<td>82</td>
<td>The Internet &amp; Networking</td>
<td><strong>Testing Network Speeds</strong>&lt;br&gt;Is your connection to the Internet really slow, or does it just feel that way? Find out for sure.</td>
</tr>
</tbody>
</table>
85 Speeding Up Your Network
Once you’ve determined that your connection needs assistance, follow these steps to get it back up to speed.

Mac Maintenance

92 Back Up Data
One of the most important things you can do for your computer, and your sanity, is to perform regular backups.

98 Declutter Your Hard Drive
To keep your Mac performing at the top of its game, make sure your hard drive is cleaned up and in order with these tips.

102 Perform Regular Maintenance
There are a handful of regular tasks you should perform to ensure your Mac keeps working properly. We’ll tell you what to do and when to do it.

Support Tricks

110 Find Solutions Online
If you still haven’t solved your computer’s problems, go directly to these sources for more information and instructions.

112 Go to the Genius Bar
Not every issue can be dealt with at home. When you need professional help, the first stop is the local Genius Bar.

114 Look Beyond the Genius Bar
If you don’t have an Apple Store near you, or if your woes are beyond its abilities, you still have other sources for professional assistance available.

116 Provide Tech Support to Others
Now that you know how to fix Macs, your friends and family will start calling on you for help. These tricks will make getting them up and running easy.
Most of us face the prospect of upgrading an operating system with a mixture of excitement and dread. True, an upgrade brings cool new ways to work. But when you’re installing OS X on your Mac, you’re tinkering with its precious virtual insides, and sometimes things can go wrong. The same is true for regular software installations and updates.

Here are some common OS X and software installation issues and remedies to make the upgrade process as trouble-free as possible.
Upgrading Your OS

You’re ready to upgrade to 10.6. Unfortunately, not all installation needs are alike, and not all installations go smoothly. Here are fixes for common problems and alternative ways to install the OS.

Prevent Installation Issues

Before installing Snow Leopard, make sure your system meets Apple’s minimum requirements—for example, Snow Leopard requires a Mac with an Intel processor; PowerPC Macs need not apply. In addition to Apple’s official specs, it’s best to have an extra gigabyte of RAM and at least 10GB of free hard-drive space for a smooth experience, both during installation and afterward.

Before you begin installing, check to see if your Mac requires any firmware updates; you can look up your computer in this Apple support article for details (macworld.com/5333). Similarly, if you’ve installed an aftermarket video card in your Mac, be sure to check with the card’s vendor to see if there are new Snow Leopard–compatible drivers you need to download and install.

Next, use Disk Utility to verify and, if necessary, repair your hard drive. The easiest way to do this is to boot your Mac from the Snow Leopard install disk; when you get to the Welcome screen, choose Utilities ▶ Disk Utilities. A major OS upgrade is also the perfect chance to check your drives for problems, clean house, and look for updates to your frequently used software. (Don’t forget to check for new versions of preference panes and other add-ons that run in the background.)

As with any major software update or upgrade, you should be sure to back up before installing Snow Leopard. If the upgrade process goes horribly wrong, the quickest way to get up and running again is with a clone—a bootable backup that’s an exact copy of your original hard drive. For instructions on backing up, see the Mac Maintenance chapter.

Solve Common Installation Problems

You’re ready to make the leap and upgrade to Snow Leopard. Unfortunately, people don’t all need the same setup, and not all installations go smoothly. Here are some fixes for problems you may run into and some other ways to install the OS.
Not Enough Hard-Drive Space

If you have a limited amount of free hard-drive space, you can opt not to install some items. Select any item in the Package Name list to view information about that item at the bottom of the window (see “Custom Kitty”).

Don’t spend too much time worrying about what to install: unlike Leopard and earlier OS versions, Snow Leopard can automatically download and install some software on demand.

**PRINTER SUPPORT** Snow Leopard makes choosing which printer software to install much easier than previous installers did. For starters, the installer automatically figures out what printer models you’ve previously used and installs drivers for them. By default, it also installs drivers for printers it detects on your local network, as well as for printers Apple deems “popular”—commonly owned printers from major manufacturers.

With this collection of drivers installed, chances are you’ll be able to use any printer you come across. If you move around a lot and regularly switch printers, you can check the box for All Available Printers, which installs every printer driver on the OS X DVD (for more details, see the Apple support article at macworld.com/5334). Snow Leopard can also download and install printer drivers on the fly.

Note that Snow Leopard does not include support for AppleTalk networking. If you used AppleTalk in the past to connect your printer with other printers over a network, you’ll need to find a different way to make that connection. One option is to connect the printer directly to one Mac (via USB, for example) and then enable the Share This Printer On The Network option in the Print & Fax preference pane for that printer. (In order to do this you’ll also have to turn on Printer Sharing in the Sharing preferences.)
Occasionally something that looks like a complete computer meltdown actually has a simple fix. Before heading to the Genius Bar or rushing into more complicated troubleshooting techniques, try these tried-and-true remedies for some of the most commonplace Mac problems: startup issues, kernel panics, and application freezes and crashes.
Printer Problems

Printing a document is usually one of the easiest things you can do on a Mac. Select File ▶ Print, and you’re pretty much done—that is, unless your printer refuses to print. Restocking the printer’s paper tray will often solve the problem, but when obvious solutions like that don’t work, figuring out what to do can be a difficult and time-consuming troubleshooting task.

Your Printer Won’t Print

If your printer completely stops printing, the best thing to do is to take a look at the following items.

CHECK THE BASICS It may seem obvious, but before taking apart your printer, you should check these basic elements of your setup. Make sure your printer is turned on and has power. Then make sure you have paper in the paper tray. Typically, if there’s no paper, a light on the printer will blink, or a message will appear on the printer’s LCD display. Check the tray even if no error message pops up on your screen. Next, check that the cable (likely USB or ethernet) connecting the printer to your Mac or router is properly seated on each end. If you have the option to use a different USB port, do so if the printer connection remains unresponsive.

If you’ve used AppleTalk to communicate with your printer in the past, you’ll find that when you

Determine the Default Make sure you’ve designated the printer you want as the default printer in the Print & Fax preference pane.
Navigation Mishaps

Now Leopard’s built-in navigation and searching tools are fairly straightforward. Should you encounter any issues, freezes, or general annoyances, try these fixes.

**Force Spotlight to Find a File**

Sometimes Spotlight refuses to find what you’re looking for, even though you know the file exists. This problem occurs when Spotlight’s indexes get out of sync. To set things right, try rebuilding the indexes, forcing Spotlight to scour your drive again and serve up the right search results.

Open the Spotlight pane in System Preferences. Click the Privacy tab and drag your hard-drive icon to the list of locations that you don’t want Spotlight to search (see “Starting Fresh”). Wait a few seconds; then select the drive and click the minus-sign button. By dragging the drive into this list, you force Spotlight to erase its index; when you remove the drive again, Spotlight notes that it is available for indexing and starts doing so.

If you have a ton of files, rebuilding the index may take a bit of time. While your hard drive is being indexed, you’ll see a pulsing dot inside the Spotlight icon. If you try to use the Spotlight menu while Spotlight is reindexing, you’ll get a message saying that it’s busy indexing your drive.

**Make Spotlight Search System Files**

By default Spotlight doesn’t search the guts of the System and Library folders. In part, this is to discourage you from tampering with essential files. But if you need to see these files, you can force its hand.

Starting Fresh  Forcing Spotlight to reindex your hard drive can fix spotty searches.
Safari

Apple’s built-in Web browser, Safari, will help you access the rapidly increasing amount of news, information, and entertainment you get from the Internet. With Snow Leopard, Apple shipped a new version of Safari. Here are some common Safari issues and fixes.

Find a Stalled Web Page

Safari’s useful Activity window (Window ▶ Activity) shows activity related to the Web pages you’re viewing. If you try to load a page and it stalls, for instance, the Activity window will show you exactly what’s causing the problem. Click the disclosure triangle next to the page in question, and you’ll see an entry for every item on the page. If an item is loaded, its size will be displayed; if it’s not loaded, a message will show its status (see “Spot the Stall”).

Handle Plug-in Crashes

Safari 4 plug-ins such as Flash and QuickTime run as processes separate from the browser. So if, for example, Flash crashes, that crash won’t take down the browser with it. You can reload the crashed plug-in without having to restart your browser. To see a list of all installed plug-ins, open Safari and select Installed Plug-Ins from the Help menu. These plug-ins can be found in your user folder/Library/Internet Plug-ins. Remove plug-ins from their folder, restart Safari, and see if that fixes the problem. If it does, check for updated versions of those plug-ins. Otherwise, determine which plug-in is the culprit and stop using it.

Disable Automatic PDF Viewing

If you click a link to a PDF document in Safari, the browser automatically loads the PDF in its current window. If you’d rather view the PDF in Preview or Acrobat or download it, you have to wait for it to load and then
Testing Network Speeds

When you test the speed of your network and Internet connections, it’s important to remember that all speeds are theoretical. If your network isn’t delivering the 54 mbps you think it should, that doesn’t necessarily mean something’s wrong. In real life, data often moves at no more than 50 percent of rated speed.

Test Your Internet Connection

There are several sites on the Web that will test the speed of your connection (by measuring the time it takes to download and upload data). Speakeasy.net (www.speakeasy.net) is one of the most popular; DSLReports.com (www.dslreports.com/speedtest) lists several more.

To get an accurate measurement, make sure that nothing else is happening on your network or over your Net connection—no automated backups, no file downloads, no streaming video, not even e-mail. If possible, plug the computer directly into your broadband modem.

Test Your Wireless Network

To find out how quickly a Wi-Fi client is connecting to your Airport base station, launch AirPort Utility, select your base station, and click Manual Setup. Then select the Advanced tab and click the Logs & Statistics button. In the Wireless Clients tab, you should see the unique MAC (Media Access Control) address of each adapter and the speed and

Speakeasy.net Speakeasy tests the speed of your Internet connection by timing file uploads and downloads to and from servers around the Net.
The first step in any maintenance plan should be setting up a reliable backup routine. Backing up your data regularly won’t prevent Mac disasters, but it will help you get back on your feet quickly when something does go wrong, whether it’s dying hard drives, corrupted data, or accidental deletions.

But while everyone knows they should back up their data, too few actually do. Using a unique 3-D interface, Apple’s backup program Time Machine attempts to turn the complex and sometimes confusing processes of backing up and restoring into simple, visual operations. Once activated, Time Machine works behind the scenes to automatically create time-based snapshots of your Mac, letting you instantly retrieve archived versions of files, folders, and programs.

**How Time Machine Works**

Time Machine copies the files on your computer to a destination you designate—such as an external hard drive or a second drive inside your Mac. Then, once per hour, the program runs again, updating your backup to include whatever files have changed since last time.

With each hourly backup, Time Machine makes what amounts to a snapshot of your entire system at that moment. If you look through the folders on your backup disk, you’ll see what appears to be a complete copy of all your files for each of numerous backup sessions. But to some extent that’s an illusion; Time Machine copies to your backup disk only those files and folders that are different from the ones in your previous backup. That way, your disk doesn’t fill up with multiple copies of files that haven’t changed.

Time Machine keeps all of the day’s backups for 24 hours, but then it begins to delete older versions to save space. You can count on it to keep the first backup of any given day for an entire month. Even after a month, it preserves the first backup of each week until your disk is nearly full. Only at that point does the program begin purging files from your oldest weekly backups. The net result is that you can see your files as they looked at many points in the past.

Keep in mind that Time Machine doesn’t work instantaneously—if you create a file and then delete it a few seconds later, Time Machine won’t
Find Solutions Online

One way to avoid re-creating the wheel and zero in on an easy solution is to search the Web. It’s likely that you are not the first or only person to have experienced your problem, so chances are good that you’ll discover solutions online.

Start with a Google Search

If you can type in the exact text of your error message or otherwise summarize your problem using a few keywords, you’re especially likely to get helpful results using Google. Use quotes to enclose exact phrases; this reduces the number of unwanted results. For example, if you type in the error message "the Preferences file could not be opened. The end of file was reached. -39", you’ll get a useful Microsoft Entourage Help Page, which tells you what to do if you have a damaged Identity database file. If you instead just type Entourage -39, you’ll have to wade through a lot of irrelevant information about HBO’s series Entourage (see “Google to the Rescue”).

Try Support Sites

If Google comes up empty, search support sites for the products that are

Google to the Rescue  A descriptive Google search is often the quickest way to find the solution to a problem.